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1. General information

1.1. Press F1 for context-sensitive help
Remember that you may press the F1 function key at any time to get help related to what you're 
doing in Cakewalk Professional.

1.2. CompuServe
An excellent alternative to technical support via phone or mail is to use CompuServe.  Type "GO 
MIDIAVEN" and switch to our section (number 3).  Messages are usually answered within 24 
hours during weekdays by Twelve Tone Systems staff and experienced users.  A variety of files 
are available for download.  Type "GO MIDI" for questions and discussion about MIDI topics 
and products not related to Cakewalk.

1.3. Drivers included with Cakewalk Professional
In general, most drivers you will use are either included with Windows 3.1 or provided by the 
manufacturer of the MIDI interface or sound card.  However, we have included two drivers on the
Cakewalk Professional diskette.

➲ IMPORTANT!  If you have a SCSI hard drive controller be sure to read thoroughly
the section below titled, "WARNING: SCSI Hard Drives"!

Music Quest
We supply a driver for Music Quest interfaces (PC MIDI Card, MQX-16, MQX-32) on the 
Cakewalk Professional diskette.  Music Quest may have newer, improved versions of this driver 
available.  You may wish to contact them or check their section of the MIDIAVEN forum on 
CompuServe.

Please see the Cakewalk Professional Installation Guide for instructions on adding or removing 
drivers using the Drivers icon of the Windows Control Panel.  Insert the Cakewalk Professional 
for Windows diskette in the drive when prompted.

Roland MPU-401 and compatibles
Windows 3.1 includes a driver for MPU-401 compatible MIDI interfaces.  You may want to use 
our driver instead.  It can be opened for output by more than one program at the same time, so 
that you don't have to quit one MIDI program before starting another.  Important: be sure to 
Remove the Microsoft driver before you Add ours.  If both drivers are installed at once, you will 
experience problems.

Please see the Cakewalk Professional Installation Guide for instructions on adding or removing 
drivers using the Drivers icon of the Windows Control Panel.  Insert the Cakewalk Professional 
for Windows diskette in the drive when prompted.

1.4. SPACEBAR, P, R, and W keys
The shortcut keys for starting and stopping playback (SPACEBAR, P) and recording (R), and for 
rewinding (W), do not work in some circumstances.  If the CAL view is active, then these keys 
need to be used so that you may type spaces and characters.  For example, you need to be able to 
type spaces in your CAL programs, so the SPACEBAR let you do that instead of starting and 
stopping playback!



Note that if the CAL view is minimized (an icon) and you click on the icon, that becomes the 
active view.  The title beneath the icon is highlighted.  Even though you are not displaying the 
window at its normal size, it is still the active window.  Thus the shortcut keys for playback, 
recording, and rewinding do not work.  Make another window active (for example by clicking on 
it) to regain the use of these keys as shortcuts.

1.5. Dump Request Macros
When you press the Receive button in the Sysx window, you may pick from a list of Dump 
Request Macros.  These are short System Exclusive messages sent to a synthesizer to make it 
dump (send back) System Exclusive data.  DRMs are defined in your WINCAKE.INI file in the 
[Dump Request Macros] section.  You may add your own DRMs or modify the ones that we have
provided.  Use the Windows Notepad to edit the file.

Please note that many DRMs have been donated by customers who are using the particular 
equipment.  In some cases we have not been able to test those DRMs because we do not have 
access to that equipment. We are redistributing such DRMs on an as-is basis.  Additional user-
supplied DRMs may be available on BBSs like CompuServe.

1.6. Saving MIDI Files containing System Exclusive banks
If a Cakewalk file has System Exclusive Auto-Send banks, then these will be saved in a MIDI 
File as System Exclusive messages at the very beginning of the song (1:1:0).  If the song has 
other MIDI data starting at 1:1:0 -- for example, notes -- it won't get played correctly because the 
System Exclusive transmission will delay the start.  The beginning of the song will sound 
"garbled".

The solution is to start the song at measure 2, for example, leaving room for the System 
Exclusive.  (A good rule of thumb is to slide everything later by 1 measure, but you could make it
longer if need be.)  If you have Tempo changes, Meter/Key changes, or Markers in your song, 
you'll have to use Cut and Paste to cut the entire song and paste it back a measure later.  If you 
have only notes in your song, you may use the Slide command instead, which is a little quicker.

1.7. Mail support
Cakewalk Professional allows sending files via Microsoft Mail or any other mail system that 
offers the MAPI Simple Mail Interface.  If you have installed such a mail system, Cakewalk 
Professional will automatically add a Send command to its File menu.  Choosing Send will call 
up the standard MAPI dialog box with the current Cakewalk Professional song file attached to the
message.

1.8. File compatibility with earlier versions
Earlier versions of Cakewalk can load a file created by Cakewalk Professional for Windows 2.0, 
but will ignore information in the file related to features which are new in 2.0.  For example, 
information in a file about the 32 new knobs in the Faders view will be ignored by Cakewalk 
Professional for Windows 1.0 when it loads the file.

Another example concerns the fields besides Comments in the Info dialog.  Earlier versions of 
Cakewalk support Comments, but do not read and display the new 2.0 fields: Title, Subtitle, 
Instructions, Author, Copyright, and so on.  If you are distributing Cakewalk files to people who 
may be using earlier versions of Cakewalk, you should consider duplicating the Author and 
Copyright information in the Comments section, so that they see it, too.



1.9. "Problem creating Staff view musical symbol font"
You may experience this problem if you have disabled True Type fonts in Windows.

The problem: When you start Cakewalk, a message appears saying "Problem creating Staff view
musical symbol font."  Press OK, and Cakewalk's window appears.  Now open the Staff view.  
The notes and staff are gigantic, and all the noteheads and clef symbols are characters from some 
other font, like Greek symbols or Latin letters.  Print Preview displays the notes and staff as very
small, all on top of each other, and uses characters from other fonts.

The solution:  Go to Windows Control Panel, double-click the Fonts icon and press the True 
Type button.  Make sure that Enable True Type Fonts is checked.  If you don't have this 
checked, then Windows won't access any True Type font, which includes ours.



2. Hardware-specific information

2.1. WARNING: SCSI hard drives
As part of Windows MIDI driver installation, a virtual device driver (VxD) file is usually 
installed.  For the two drivers we provide, this file is named VMPUD.386 for MPU.DRV (MPU-
401) and VMQX.386 for MQX.DRV (Music Quest).  This VxD file is only used when you run 
Windows in 386 Enhanced mode.

The purpose of the VxD
The Twelve Tone Systems VxD reads the card's base address from SYSTEM.INI (which you set 
using Control Panel Driver Setup) and traps accesses from that address to that address plus 10h 
(10 hex or 16 decimal).  The goal of this VxD is simply to prevent DOS programs from accessing
the card and interfering with the Windows driver's handling of the card while Windows is 
running.  If an access is detected, the VxD displays an error message and simulates a dead card to
the "offending" DOS program.  The Twelve Tone Systems VxD is based on the original Microsoft
VxD sample code and works the same way over the same address range.

Why are addresses trapped from the base address to the base address plus 10h, when supposedly 
the MPU-compatible cards only use addresses from the base address to the base address plus 1?  
Many MPU-compatible cards, such as the original Roland MPU-401 and Music Quest cards, 
actually respond to other addresses within that 10h range.  When set at base address 330h, the 
Music Quest PC MIDI card has been reported to respond to 332h-337h as well, and the MPU-401
has been reported to respond to 338h-339h.  Apparently, these cards do not decode all the address 
lines.  Thus the safest, most-complete approach when dealing with MPU-compatible cards is for 
the VxD trap the whole range of 10h addresses.

The potential problem with SCSI cards
Unfortunately, it has also been reported that if the access comes from a SCSI card trying to access
a SCSI hard drive within DOS, the error message never appears and DOS hangs.  Hard drive 
data loss is a possibility.  SCSI card owners should beware of setting their SCSI card 
address anywhere within this range.  If it doesn't conflict with the card directly, then it will 
conflict with the VxD like this in enhanced mode if it's installed.  If you're sure you aren't 
conflicting with your card, you can decide to forego the VxD protection by removing the VxD.

Removing a VxD .386 file
If you decide it's safe to remove the VxD, here's how to do it.  Although Control Panel's driver 
installation knows how to install the VxD file associated with a driver, its driver removal does not
know how to remove it.  Therefore, an installed VxD will remain forever installed, unless you 
remove it manually.  To do this, edit SYSTEM.INI with a text editor like the Windows Notepad.  
Find the line DEVICE=VMPUD.386 or  DEVICE=VMQXD.386 under the section [386Enh] and
delete it. Save the file and restart Windows.  If you ever re-install the driver using Control Panel, 
you'll have to do this again.

2.2. Wave events and MIDI input using Sound Blaster
Certain older models of the Sound Blaster cannot do both MIDI input and wave output at the 
same time.  (However, the latest Sound Blaster cards, such as the Sound Blaster 16, are fully 
capable of performing MIDI input and wave output simultaneously.)  Thus, if you've selected 
"Creative Labs" as a MIDI In device in Cakewalk's Settings/MIDI Devices dialog, wave audio 
won't work.  This includes Cakewalk's special Wave and MCIcmd events as well as wave audio 
attempted by any other Windows application running while the "Creative Labs" MIDI In device is



open.  This is not a limitation of Cakewalk: while any program is using the older "Creative Labs" 
MIDI In device, wave audio will not work.

Note that MIDI output will work fine along with wave audio: you can select "Creative Labs" 
from the list of MIDI Out devices.  The problem occurs only when you've selected the "Creative 
Labs" MIDI In device.

2.3. Striping a tape with "Smart FSK" or CLS
If you are striping a tape with a form of "Smart FSK" (for example, Music Quest's Chase Lock 
Sync), you need to check that an option in MIDI Out is turned on while you are striping the tape.
This option is Transmit Start/Continue/Stop/Clock, which is off by default.  If this option isn't 
checked, striping won't be successful.  Why?  These forms of sync basically encode MIDI Sync 
information in a special code on tape.  Therefore to create the code you must have Cakewalk emit
MIDI Sync by checking the Transmit Start/Continue/Stop/Clock option.  And once the tape is 
striped, remember that in order to have Cakewalk play in sync to Smart FSK or CLS, you need to 
use the Clock command and choose MIDI Sync" (or press the Control bar clock button until it 
reads "MIDI").

2.4. MIDI Time Piece Tips and Tricks
These comments are to help you use the MIDI Time Piece (MTP) made by Mark of the Unicorn 
(MOTU).

1.  In Windows, input ports are separate.  This means that the System Exclusive receive buffers 
Cakewalk uses are distributed among all the input ports.  Using Cakewalk's MIDI Devices 
command (on the Settings menu), you may need to de-select all input ports except for the one 
receiving the System Exclusive.  This ensures that there are enough buffers for the desired port.  
After the System Exclusive dump, you can return to MIDI Devices to switch the input port back 
to receive your MIDI controller's data.

2.  "FAST 1X" mode of the MTP may exhibit strange behavior with System Exclusive send.  This
is a result of the MTP's "middle-man" processing techniques.  The MTP Windows driver is not 
allowed to send System Exclusive through the MTP byte by byte.  The MTP stores System 
Exclusive in a buffer to be sent out in larger, faster packets.  This causes checksum errors on a 
Sound Canvas, for example.  We are able to send System Exclusive to the Sound Canvas in FAST
1X mode by lowering the TTSSEQ.INI's SendSysxPacketSize parameter to 344.  This 
number will differ for individual computer systems.  Use FAST 1X mode with System Exclusive 
"at your own risk".

3.  MOTU's MTP setup software is a DOS program and doesn't currently run together with the 
Windows driver in Windows 386 Enhanced or Standard modes.  To use the MOTU setup 
program, exit Windows altogether.

4.  MOTU provides a starting template for their setup software called WINDOWS.MTP.  This 
should be loaded (hint: see item 3) before using the MTP as an interface in Cakewalk 
Professional for Windows.  The MTP driver will access the MTP's current state as configured by 
WINDOWS.MTP rather than reinitializing it.  This will allow you to customize the provided 
template using MOTU's MTP software, and then access this setup in the Windows driver.

5. When connecting two MTP's together for 16 input/output ports, put the unit assigned to ports 
1-8 first in the chain.  Then, connect the network cable from the back of this unit to the network 



input on the second unit (ports 9-16).

6.  Since the MTP has a 17th port for sync input, you will see this in the Cakewalk Professional 
MIDI Devices list as a separate input port option.  Cakewalk Professional supports a maximum 
of 16 input ports.  If you have two MTP's using all 16 input ports and are using SMPTE sync, one
input port should be deactivated in MIDI Devices in favor of using that 16th available input port 
as your sync port.  Also, sync audio input should be read on the first MTP.  This configuration is 
based on the routings of the provided WINDOWS.MTP template.

2.5. Patch Names
Cakewalk Professional for Windows lets you refer to patches using names instead of numbers.  
Names are provided for the factory preset patches of various kinds of synthesizers.  With some 
synthesizers, you may need to configure the synthesizer in a certain way before the patches 
corresponding to the names are available.  You'll find some tips to get you started below.

You may add or change patch lists by editing the PATCHES.INI file.  The next time you start 
Cakewalk, the changes will take effect.  You will see the message "Compiling PATCHES.INI" 
while your changes are being converted by Cakewalk into a PATCHES.BIN file.  (Subsequently, 
Cakewalk uses PATCHES.BIN because it can be read much more quickly than PATCHES.INI.)  
Once Cakewalk starts, use the Patch Names command from the Settings menu to choose your 
newly-created list.

Please note that the Windows Notepad application cannot handle text files larger than 32K, and 
PATCHES.INI exceeds that limit.  Instead of Notepad, use the EDIT command found in MS-DOS
5.0 or higher, or, some other text editing application capable of handling larger text files.  Do not 
edit the file using a word processing program like Windows Write, because it does not store plain 
text files.

CT-470 Upper Tone Bank
These are the default patches, numbers 0..109.

CT-470 Lower Tone Bank
You must press the SELECT button on the CT-470 to change it to the lower position before the 
patches with these names will be available on the CT-470.

CT-470 Beat Bank
The CT-470's Channel 4 button must be assigned to the Beat Bank and its sync mode set to 
external clock.  Please see the Casio manual for more information about the Beat Bank.  In 
Cakewalk, choose the MIDI Out command from the Settings menu and check the option, Use 
Start, Never Continue.

D110 Preset Tones
Uses the default Timbre Bank.

VFX 2.1 ROM Programs
Be sure to select the ROM bank on the VFX or VFX-SD.

MIDIVERB III
These names are for the preset effects 0..99.  Customized internal effects will respond to program 
changes 100..127.  (If you have internal effects with MIDIVERB III program numbers 128 and 



higher, you can use its mapping feature to bring those down into the 0..127 range, perhaps 
substituting presets that you don't use.)

2.6. Hewlett-Packard LaserJet 4
Printing from within the Staff view may lead to General Protection Faults in the LaserJet 4 
Windows driver.  Obtaining the latest version of the driver may solve this problem.

As this is written, the latest version of the driver is 31.V1.26.  (To see the version number of the 
driver from within Cakewalk, choose Print Setup, select the LaserJet 4, press the Options 
button, and then press the About button.)

To obtain the latest version of the driver, please call HP Driver Distribution at 303-353-7650.

2.7. Gravis UltraSound
Cakewalk Professional for Windows 2.0 adds support for sound cards which use "patch caching", 
like the popular Gravis UltraSound.  These cards load sounds from your hard drive as needed.  If 
you are using this kind of sound card, the Update Patch Cache command on the Realtime menu 
will be enabled.  When you choose this command, Cakewalk examines your song to see which 
Patch numbers you have used.  It gives this list to the sound card, which loads the required 
sounds.  This process can take some time, so Cakewalk lets you control when to "recalculate" the 
patches used, by you issuing the Update Patch Cache command.  (Cakewalk also performs  the 
"recalculation" when you use Open or New to open or clear a song file.)

If you are using the Play List view, please be aware that you may experience a delay between 
songs due to the need to load the sounds required for the next song.  This does not reflect any 
potential problem with Cakewalk, it is simply the way such a sound card must work.



3. Changes in this release
Following is a list and brief description of some problems that were fixed in this maintenance 
update, version 2.01.  Although the primary goal of a maintenance release is to fix problems, we 
have added a few new features, which are also described here.

Record Mode (The return of "Auto Punch")
The Overwrite Mode menu option has been renamed Record Mode.  It presents three options.  
Two were available in 2.00: Sound on Sound and Overwrite Mode.  The third option, Auto 
Punch, is "new" -- it had been removed going from version 1.0 to 2.0.  Auto Punch lets you 
specify exact punch in and out times before you begin recording.

Please press the dialog's Help button for more information.

Tempo dialog
When you click on the Tempo in the Control bar, a dialog box appears. In version 2.00, this let 
you type in a new value to for the most recent tempo change in the Tempo Map.

In version 2.01, this dialog also lets you insert a brand new tempo change at a time you specify.  
This can be a useful alternative to drawing tempos in the graphical Tempo view, especially when 
you want to enter a series of tempos with precise numeric values and precise times.

Finally, you may supply the tempo value either by typing it (as before), or, by clicking the mouse 
to tap the rate you desire.

Please press the dialog's Help button for more information.

Bank Select CAL programs
This release includes a new CAL program called BANKSEL.CAL.  It helps you insert the MIDI 
events to choose a bank and patch number.  When you run it, it asks you for the time of the 
bank/patch change.  Next you are asked for two controller numbers and a patch number.

The official MIDI Bank Select method is to use two controller messages immediately followed by
a patch change.  The first controller is number 0, and the second is number 32.  The combination 
allows bank numbers ranging from 0 to over 14,000.  Most synthesizers, however, pay attention 
to only one of these two controllers (either 0 or 32).

Please consult your owner's manual for more information about which controller it uses.  Simply 
type in the number "0" for whichever controller your synthesizer does not use, since your 
synthesizer will ignore it.  If you are unsure which controller your synthesizer uses, try supplying 
your desired bank number for both controller values.

Remember that bank numbers start with 0, not 1, in a MIDI controller event.  You may need to 
subtract one from the bank number as it appears on your synthesizer's front panel or in its 
documentation.  The same is true for the patch change number you supply using this CAL 
program.



An additional CAL program helps you with synthesizers which pre-date the Bank Select message 
and use a pair of patch changes to choose a bank and patch.  This program is BANKSELP.CAL.  
The "P" stands for patch.  You are asked for the two patch changes numbers.

Both CAL programs delete any existing bank- and patch-related events at the specified time, then 
insert the new ones you want.

Note: Be sure to select just one track before running the CAL program.  This should be the track 
in which you want the bank/patch events to be inserted.  You may find it helpful to open an Event
List view for that track, so you can see the events which the CAL program inserts for you.

Spin buttons
When using spin buttons -- the up and down arrow buttons which let you increment and 
decrement numbers -- sometimes the right mouse button could become "stuck".  This was fixed.

Remember Layout
The documentation for Remember Layout (on the Options submenu of the View menu) has the 
following instructions:

To set up a layout and protect it from changing
1. Turn on Remember Layout.
2. Arrange your windows as desired.
3. Use Exit to quit Cakewalk.
4. Restart Cakewalk.  Turn off Remember Layout, and answer No to the question, Restore 
'factory default' layout?

Following these instructions did not work in 2.00.  This procedure now works in 2.01.  Cakewalk 
will use the last-saved window layout, and will not overwrite it when you exit the program.

Control bar position
If the main Cakewalk window was not maximized and you'd tacked the Control bar on the right 
or bottom edge, it might not be drawn correctly when you first started Cakewalk.

Play List view
� A crash could occur if the On check box were turned off during playback.

� A crash could occur if a song were deleted from the list during playback.

Staff view
At certain PPQ and meter combinations, notes dragged near the end of a measure might jump to 
the start of the measure.



MIDI Files
� There were problems reading some kinds of Text meta-events from MIDI Files.

� MIDI File meta-events at times other than 1:1:0, and referring to System Exclusive banks 
containing multiple System Exclusive messages, would result in meta-events written to the MIDI 
File with the individual messages spread out in time rather than immediately following each 
other.

File Info
� The  total editing time showed in the Stats dialog would sometimes show an incorrect value 
for the Minutes.  This was "merely" an error converting the time for display in Hours, Minutes, 
Seconds format.  The internal time was stored correctly and will be displayed correctly when you 
view the file using this latest release.

� You may now resize the File Info dialog box so that you can view more of the 
Comments notepad.  (You may even press the Maximize button in the upper-right corner 
of the dialog box window to make it occupy the entire screen.)  If you are using the 
Remember Layout option (located on the Options submenu of the View menu), the File
Info dialog size and position will be remembered just like your other windows.

Patch Caching, Gravis UltraSound
� The error message, "Not enough memory on your sound card to hold all the patches used in 
this song", could appear when you selected the New command from the File menu or under other 
circumstances when it was unlikely that there is insufficient memory on the sound card.

� The key for the MIDI Metronome in the Metronome dialog sometimes wasn't cached (that is, 
you wouldn't hear any sound).

CAL
If your CAL program depends on any of the following changes or fixes, you may use this test:

(>= VERSION 21)
The CAL VERSION was 20 in Cakewalk version 2.00.  It is 21 in Cakewalk version 2.01.

� The sendMIDI function was not transmitting WHEEL events.

� When sending the sendMIDI command to Cakewalk via DDE Execute transaction, it worked, 
but there was a spurious CAL error message displayed, "Types do not match".

� When issuing the following CAL commands via DDE, there was a spurious "Types do not 
match" error:  FileNew, FileOpen, FileSave, FileSaveAs, FileMerge, GotoSearch, EditCut, 
EditCopy, EditPaste, EditPasteToOneTrack

� Using (FileSaveAs <filename>), the form where a specific filename argument is supplied, did 
not work.  The argument was ignored and the user prompted for the filename anyway.



� The (GotoSearch [<dummy>]) and (GotoSearchNext) functions were not documented, but 
were recorded into CAL programs.  They did not work when run -- you got a "wrong number of 
arguments" error.  Both commands now work and are fully documented in online help.

� The following commands were recorded into CAL programs, but resulted in an "unknown 
function" error when the program was run: (SettingsMidiIn), (SettingsRecordFilter), and 
(SettingsChannelTable).

New TTSSEQ.INI settings for System Exclusive
Some MIDI equipment has special timing requirements when receiving System Exclusive 
transmissions.  If your equipment has problems receiving System Exclusive from Cakewalk, you 
might need to introduce some small delays to allow the equipment to digest the information it is 
receiving.

Two new TTSSEQ.INI settings were added to control the timing of  System Exclusive 
transmissions.

SysxDelayAfterF7 = <0 or 1> Default: 0
SysxSendDelayMsecs = <milliseconds> Default: 60

There already was a SysxSendPacketSize (default = 1024 bytes) setting, which is the number of 
bytes sent before a delay is introduced.  The delay was previously hardwired at 60 milliseconds.  
The new setting SysxSendDelayMsecs (default = 60 milliseconds), adjusts the length of the 
delay.  

The new setting SysxDelayAfterF7 (default = 0), causes Cakewalk to delay if it encounters an F7
in a System Exclusive bank.  This delay amount is also controlled by the new setting 
SysxSendDelayMsecs.

Some devices (such as the Roland GR-50 and GR-1) have a problem receiving System Exclusive 
sent from Cakewalk until you add this single line:

SysxDelayAfterF7 = 1

This gives the device extra time to process each System Exclusive message.

________________________________________________________________
There is no additional information at this time for README.WRI.


